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ABSTRACT 

An Application for Barrage Calculations and Design (ABCD) v1.0 was developed for the 

Design of Small Barrages for the East Indian region using Python programming language, 

HTML and Inkscape. ABCD v1.0 calculates the hydraulic parameters of a barrage that are set 

in consideration of surface flow, subsurface flow and nature of the foundation soil by Hydraulic 

Jump theory and Khosla’s theory. It solves the uplifting pressure head distribution on the 

structure using regression from Khosla’s pressure curves, allowing for the approximately 

perfect design of structures built on anisotropic and shallow as well as isotropic and deep 

permeable media with and without consideration of concentration and retrogression. The app 

also provides the hydraulic design parameters for the Canal Head Regulator provided at the 

head of the off-taking canal. Testing and validation of the app is also demonstrated using 

problems from books written by famous authors. ABCD v1.0 serves as a convenient decision 

tool for the hydraulic design of small barrages. 

Keywords: Barrage; hydraulic jump; Khosla’s theory; retrogression; Canal Head 

Regulator; python. 
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CHAPTER 1: INTRODUCTION 

1.1 GENERAL 

An artificial obstruction or simply, a barrier built in a watercourse so as to raise the upstream 

water level, and thus, to feed the main canals taking off from its upstream side at one or both 

of its flanks is called Barrage. In this hydraulic structure, most of the ponding is done by the 

gates and a smaller part of it is done by the raised crest. 

Barrage gives less afflux and hence, a better control upon the river flow, because both the 

inflow and outflow can be controlled to a much greater extent by suitable manipulations of its 

gates.  

Figure 1.1 shows the Naraj Barrage at Odisha, India. 

 

Figure 1.1 Naraj Barrage, Odisha, India 

1.2 PROBLEM STATEMENT 

The design of a hydraulic structure comprises of following two steps: 

• Hydraulic design, for fixing of the overall dimensions and profiles of the structure, and 
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•  Structural design, in which the various sections are analyzed for stresses under different 

loads and different reinforcement and, additionally other structural details are worked 

out. 

We have to automate the process of Hydraulic Design so that Barrages can be designed more 

efficiently and within the stipulated time. 

1.3 OBJECTIVE OF THE STUDY 

The primary purpose is to develop an application for the design of small barrages.  

The specific objectives are: 

• Model the Application in Excel using formulas and Excel functions. 

• Coding it for Software Development. 

• Graphical and Design Considerations, incorporating GUI. 

• Application Test. 

1.4 SCOPE AND LIMITATION OF THE STUDY 

The primary purpose of this research work is to understand the design considerations for 

constructing a barrage and use them to model the whole process in a computer software. 

Besides that, the study will aim at developing user-friendly GUI and Help documentations for 

the ease of users. The application will be tested based on problems given in popularly followed 

books and the results will assist in re-designing the complete software if required. It will be 

based on [1], Construction of Concrete Barrages - Code of Practice, Bureau of Indian Standards 

and [2], Hydraulic Design of Barrages and Weirs, Bureau of Indian Standards. 

1.5 SIGNIFICANCE OF THE STUDY 

The significance of this study is the ease which designers will be experiencing in designing 

small barrages. The application will serve as a powerful tool as far as time and resources 

required in manual designing are concerned. 
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CHAPTER 2: LITERATURE REVIEW 

Until recently, [3] creep theory was being adopted for designing weirs with parts on sand or 

alluvial soil. The theory assumed the total head loss up to any point along the base to be 

proportional to the distance of the point from the upstream of the foundation. Bligh’s method 

does not discriminate between the horizontal and vertical creeps in estimating the exit hydraulic 

gradient. This theory has been found to be defective from actual field observations due to the 

inherent assumptions of creep length. 

[4] first developed a general theory and a large number of individual solutions of the conformal 

transformation problem as applied to weir-foundation design. Apart from the purely 

mathematical analysis, his investigation comprised model-tank tests and “electric-analogy” 

method. 

[5] based on his experiment on a large number of dams, proposed a method in which the creep 

is weighted to allow for the variation in creep along vertical and horizontal directions. It is an 

improvement over the Bligh’s creep theory but the method for determination of uplift pressure 

is criticized because it is an empirical method and not based on any mathematical approach. 

The method of flow nets was first developed by Forcheimer and then formalized by [6]. The 

method is a graphical solution of the Laplace equation for steady state flow. The flow nets are 

constructed by dividing the soil profile under the foundation into an arbitrary number of 

equipotential (same head) and flow lines. Trial and error achieve the solution. 

[7] evolved the “method of independent variables”. In this method the base of the structure is 

broken into simple and common profiles. He established that the loss of head does not take 

place uniformly in proportion to the length of creep. But it depends on the profile of the base 

of the weir. He also established that the safety against undermining is not obtained by flat 

hydraulic gradient but should be kept below a critical value. The ratio of the uplift pressure of 

a particular weir founded on permeable soil at any point along the base to the total head is 

constant and independent of nature of subsoil as long as it is homogeneous. The fundamental 

principle of the method is that an approximate result can be arrived at by splitting the complex 

foundation profile into several elementary forms. 

Finite difference approximation was one of the earliest methods known to be used successfully 

for solutions of ground water problems [8]. Other approaches, such as finite element [9] and 

boundary element [10] have been introduced later. The finite difference method is 
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straightforward and flexible that the non-linearity’s arising from changes in parameter values, 

such as the change between confined and unconfined states can be included without difficulty 

[11]. 

A steady-state model which employed the SOR [12, 13] technique to solve finite difference 

equations simulated steady flow for either saturated or unsaturated conditions or for a 

combination of the two (water table condition). 

Finite element method was suggested by [14] as an alternative to Khosla’s theory for 

subsurface flow prediction since it can also take into account soil non-homogeneity and 

anisotropy. 

[15] used conformal mapping technique to obtain an exact solution for seepage flow beneath a 

hydraulic structure having the permeable soil of infinite depth as the foundation for a flat and 

stable floor with an inclined cut-off present at the downstream end. The exit gradient was found 

to decrease considerably along a distance beyond the floor end with an increase in cut-off 

inclination. He found that using an inclined cut-off enhances the factor of safety in design 

against uplift and piping. 

[16] used spreadsheet program to solve Laplace equation using finite difference method with 

the appropriate boundary conditions. The calculation results were found to have excellent 

relations with experimental results. 

Finite difference method based on boundary-fitted coordinate transformation was applied to 

analyze the steady seepage flow in a lock foundation, a foundation pit, and an embankment 

dam with a free surface. 

[17] developed a method of minimizing the cost of a barrage using an optimization technique 

by doing a parametric analysis to gain insight into the effects of various parameters on the 

optimal barrage design. 

The FLOWNS model was developed for generating flow nets for any saturated rectangular 

domain with any combination of the constant head or constant flux boundary conditions. The 

FLOWNS program solves using discrete values approximation, the continuous distributions of 

the stream and potential function using finite-difference approximations of the Laplace's 

equation. The distribution of hydraulic conductivity may be anisotropic and heterogeneous 

[18]. 
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[19] studied analytical creep theory using two-dimensional finite difference computer model 

for the design of low head hydraulic structures. They found that seepage under hydraulic 

structure is a complex problem that can be adequately solved using a numerical model. 

Comparison of numerical model results shows that actual distribution of potential along the 

tin-creep length is non-linear against Bligh's Creep theory which suggests a linear distribution.  

[20] developed a Windows-based program named WINDWEIR in Visual Basic.NET 

programming language for the optimum design of a diversion weir with the sidewise intake. It 

determines the overall dimensions of each of the components of the diversion weir and the total 

cost of the whole structure. It also performs stability analysis. 

For surface flow problems in a diversion structure, analysis of a hydraulic jump is required. 

Commonly in any hydraulic jump, eight variables are involved. Six independent equations 

relate these variables. If any two variables are known, the remaining six can be worked out by 

using these six equations mathematically. Since the mathematical solution is complicated, 

curves as suggested by [21] are used to avoid large-scale calculations by taking the q (discharge 

intensity) and HL (head loss) as known variables [22]. 

 

 

 

 

 

 

 



CHAPTER 3: MODEL DEVELOPMENT - 

THEORY 

3.1 INTRODUCTION 

The complete design of a modern glacis-wier or, a barrage can be divided into two main 

aspects, i.e. 

1. Hydraulic Design 

2. Strctural Design 

The hydraulic design involves determining the section of the barrage and the details of its 

upstream cutoff, crest, glacis, floor, protection works u/s and d/s, etc. The hydraulic design of 

barages on permeable foundation may be classified into: 

1. Design for Sub-surface flow; and 

2. Design for Surface Flow 

Khosla’s method of independent variable is invariably used for determining the uplift pressures 

exerted by the seeping water on the floor of the barrage. The safety of the structure against 

piping has to be checked by keeping the exit gradient within safe limits. 

3.2 HYDRAULIC DESIGN FOR SUB-SURFACE FLOW 

The sub-surface flow underneath a barrage causes two distinct instability issues, as recorded 

below and outlined in Figure 3.1. 

1. Uplift forces because of the sub soil weight that tends to lift up the barrage raft floor, 

and 

2. When the seepage water holds adequate residual force at the emerging downstream end 

of the work, it may lift up the soil particles. This prompts increased porosity of the soil 

by progressive removal of soil form beneath the foundation. The structure may 

ultimately subside into the holow so formed, resulting in the failure of the structure. 
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Figure 3.1 Effect of sub-surface flow below barrage floor 

Seepage forces would be the most overwhelming for closed gates condition, but would also 

exist amid some instances of full flow conditions, as appeared in Figure 3.2. 

 

Figure 3.2 Seepage line gradient changes (a) steepest during no flow; (b) Average during medium flood; 

and (c) Almost none during high floods. 

It may be noticed that during these flow conditions, a part of the uplift forces due to seepage 

flow is negated by the hydraulic pressure on the downstream side. Under the gates closed 

condition, water depth on the downstream side is rather smaller. 

Keeping in mind the final goal to assess the uplift forces due to the seepage flow, it may be 

advantageous to recall the mechanism of such flow, as seen from Figure 3.2, the distribution 

of the sub-surface pressure of the water held inside the pores of the soil is such that it changes 

from a maximum value along the upstream river bed to a minimum value at the d/s end of the 

river bed. The pressure head differential between the upstream and downstream is shown as a 

percentage and is denoted by ɸ. A correlation of pressure distribution beneath the barrage floor 

from Figs. 3.3(a) and 3.3(b) demonstrate that the introduction of sheet piles reduce the pressure 
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below the barrage raft floor. Actually, the seepage paths increase because of the introduction 

of sheet piles, therefore reducing the gradient of sub-surface pressure. 

 

Figure 3.3 Distribution of equipotential lines (a) Barrage floor without sheet piles; (b) Barrage floor with 

sheet piles at upstream and downstream ends. 

It may be noted from the figure that the following expression gives the pressure at any location 

of a certain equipotential line: 

 

Where, HU is the head of water on the upstream pool above datum and HD is the head of tail 

water above datum. 

 

Figure 3.4 Streamlines and equipotential lines below barrage floors and sheet piles. 
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If a flow net is constructed using both sub-surface equipotential lines as well as streamlines 

(Figure 3.4), an estimate may be made of the seepage discharge as given below. 

Assuming that a flow channel is designated by the space between two adjacent streamlines, 

(Figure 3.4) then the stream flow through all such stream channels might be viewed as equal 

and adding up to, say, Δq m3/s per metre width. If there are Nf flow channels, then the total 

seepage flow q would be expressed in the following manner: 

q = Nf Δq 

Darcy's law governs the quantity Δq is 

Δq = k Δh / Δs Δn 

In the above expression k is the coefficient of permeability, Δh is considered as the potential 

drop between two consecutive equipotential lines, Δs is the taken as the potential length along 

the stream line of ‘square’ flow net and Δn is the length normal to the streamline and the 

pressures. Δs and Δn are approximately equal and Δh is equivalent to Hdiff / Nd where Hdiff is 

the head difference between the upstream pool and the d/s tail water level and Nd is the quantity 

of equipotential drops between the upstream and the downstream stream bed. Hence, 

q = Nf k (Hdiff / Nd) = k Hdiff (Nf / Nd) 

The above expression empowers the calculation of the quantity q. 

The seeping water beneath the barrage applies a dynamic pressure against the stream bed 

particles through whose voids the water is flowing. This might be evaluated by considering a 

little cylindrical volume of length Δl and cross-sectional area ΔA in appropriate units. The 

seepage force on this little volume arises due to the difference in pressure on either side of the 

cylindrical volume. 
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Figure 3.5 Forces on an infinitesimal cylindrical volume aligned along a streamline. 

In Figure 3.5, these pressures are shown as p on the upstream and p + Δp on the downstream 

sides of the little volume. As obvious, the higher pressure being on the upstream side of the 

bed, Δp would come out to be negative. An expression for calculating the seepage force ΔF 

acting on the considered cylindrical elementary volume may be expressed as: 

ΔF = p. ΔA - (p + Δp).ΔA 

This expression yields 

ΔF = -Δp. ΔA 

Thus, the seepage force for unit volume of soil will be given as: 

ΔF / (ΔA.Δl) = -(Δp /Δl) = -ρ g.(ΔH/Δl) 

Where ΔH is the difference in the head of water on either side of the small volume. ΔH will be 

negative, since the pressure head drops along the direction of flow, and hence the quantity on 

the right side of the equation would, as a result, turn out to be positive. 

At the exit end, where the streamline meets the river bed surface (B in Figure 3.5), the seepage 

force acts vertically upwards and against the weight due to the volume of solid held in the soil. 

If the seepage force is sufficiently high, it would result in sand-boiling, accompanied by the 

ejection of sand particles bringing on production of pipe-like voids through the stream bed, 

while on the other hand, the stream bed particles at the point of entry (A in Figure 3.5) do not 

face such an issue, since both the seepage force as well as the particle weight are directed 

vertically downward. 

To provide safety against piping failure at the exit end, the value of the submerged weight (w) 

of the solid must be greater than or equal to the seepage force. This can be expressed as: 
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w= (1-n)*(ρs-ρ)*g ≥ -ρg (ΔH/Δl) 

In the above expression, w is the submerged weight of the solids with a void ratio n. ρs and ρ 

represent the density of the solids and water, respectively. The equation then simplifies to 

-ΔH/Δl ≤ (1-n)*(G-1) 

Where G is soil’s relative density. 

The quantity ΔH/Δl is known as the hydraulic gradient of the sub-surface water of the 

streamline at the exit end, and is also named as the Exit Gradient. This should not exceed the 

given value to prevent piping-failure. Taking G and n to be roughly equivalent to 3.65 and 0.4 

respectively for sandy bed, the limiting estimate of |ΔH/Δl| ends up being nearly equal to 1.0. 

However, it is insufficient to fulfill this limiting condition. Even a slight increment in the 

quantity will upset the stability of the sub-soil at the exit end. This requires the use of a generous 

factor of safety in the designs, which might be considered as a precautionary measure against 

uncertaintie, for example: 

• Non- homogeneity of the soil in foundation  

• Difference in the pore space and packing 

• Local intrusion of impervious material e.g. clay beds or very porous material 

• Fissures and faults in sub-soil formation, etc. 

As per the guidelines of the Bureau of Indian Standards [2], the following factors of safety may 

be taken into account for the variation of river bed material: 

Table 3.1 Factors of safety for different soil materials 

Sub-soil Material Factor of Safety 

Shingle 4 to 5 

Coarse Sand 5 to 6 

Fine Sand 6 to 7 

 

3.3 SEEPAGE PRESSURE AND EXIT GRADIENT 

COMPUTATION 

 

With the coming up of numerical computational devices, tools and PCs with high precision 

speeds, accuracy, numerical solution of the Laplace equation representing the sub-surface flow 
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has turned out to be quite common nowadays to assess the above parameters. However, 

analytical solutions have been determined by a group of engineers and researchers in India 

comprising of A.N. Khosla, N.K. Bose and M. Taylor and exhibited in basic analytical 

structures and plates or graphs. These can be utilized to arrive at a quick answer to a given 

problem. They managed to put forth these equations after conducting numerous experiments 

and solving the Laplace equation under more simplified conditions using the transformation 

theory given by Schwartz Christoffel. The results of their numerical solutions have been 

published under publication no. 12 titled “Design of weirs on permeable foundations” of the 

Central Board of Irrigation and Power. Obviously, the soil confined below a barrage 

construction complies to a intricate shape and is not promptly managable to solution using 

analytical formulae but still the following basic profiles have been observed to be very valuable 

for roughly arriving and estimating the subsurface pressures of a barrage or a canal head 

regulator floor. 

 

Figure 3.6 Simple standard profiles for determining sub-soil pressure at key points. 

•  A straight horizontal floor of negligible thickness with a sheet pile at either end  

[Figure 3.6(a) or 3.6(b)]. 

•  A straight horizontal floor of negligible thickness with an intermediate sheet pile 

[Figure 3.6(c)]. 
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•  A straight horizontal floor depressed beneath the bed but without any sheet pile  

[Figure 3.6(d)]. 

Mathematical solutions of flowets for these simple standard profiles have been presented n the 

form of some equations and graphs which can be used to determine the percentage pressures 

at variousss key points. Key points are the intersection of the floor and the pile lines on either 

side, and the base point of the pile line, and the base corners in case of a depressed floor. The 

expressions for each of the above cases are given below: 

 For sheet piles at either upstream end [Figure 3.6(a)] or the downstream end [Figure 

3.6(b)]. 

ɸE = (1/π) cos-1[(λ-2)/ λ] 

ɸD = (1/π) cos-1[(λ-1)/ λ] 

ɸC1 = 100 – ɸE 

ɸD1 = 100 – ɸD 

ɸE1 = 100 

where  λ = (1/2)[ 1+√(1+α2) ] 

and  α = (b/d) 

 For sheet piles present at the intermediate point [ Figure 3.6(c) ] 

ɸE = (1/π) cos-1[(λ1-2)/ λ2] 

ɸD = (1/π) cos-1[(λ1)/ λ2] 

ɸC = (1/π) cos-1[(λ1+1)/ λ2] 

where λ1= (1/2)[ √(1+α1
2) - √(1+α2

2)] 

 λ2= (1/2)[ √(1+α1
2) + √(1+α2

2)] 

α1 = (b1/d) 

α2 = (b2/d) 

 In case of a depressed floor 

ɸD' = ɸD - (2/3)[ɸE -ɸD] +(3/α2) 

ɸD' = 100 – ɸD 

ɸD = (1/π) cos-1[(λ-1)/ λ] 

ɸE = (1/π) cos-1[(λ-2)/ λ] 

The above quantities may also be calculated from the graph shown in Figure 3.7. 
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Figure 3.7 Curves given by Khosla, Bose and Taylor for the estimation of uplift. 

For the d/s sheet pile [Figure 6 (b)], the exit gradient, denoted as GE, is given below: 

GE = (H/d) (1/ π√λ) 

Equivalent graphical form of the above equation is as shown in Figure 3.8. It provides a valve 

of GE equivalent to infinity if there is no presence downstream sheet pile (d=0). It is, hence, 

essential that presence of a downstream sheet pile is invariably necessary for any barrage floor. 

The value of exit gradient must not lesser than or equal to the critical value of the soil 

comprising the river-bed material. 
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Figure 3.8 Curves for measuring Exit Gradient 

3.4 BARRAGE SURFACE FLOW HYDRAULICS 

A barrage built over a river needs to pass floods of varying magnitudes every year and the gates 

must be operated in a manner that the water level of the pool is kept equaaal to or more than 

the Pond Level (PL). A very high flood would require the opening of all the gates to give an 

approximate obstruction-less flow of the flood. For smaller floods, the gates might not need to 

be opened completely to provide unhindered flow. The gates of all the bays are not usually 

opened uniformly, but are opened more towards that side of the barrrage, where more flow is 

to be pulled out due to certain site-particular reasons. All things considered, the prerequisite of 

keeping up pond level means that as the flood rises in a stream, more and more gate opening is 

provided until such time is encountered when the gates are completely open. 

Curve for stage-discharge for the upstream side is as shown in Figure 3.9(a) indicates that up 

to a stream discharge of Q0, the water level behind the barrage is kept at Pond Level. At higher 

values of discharge, the stage discharge curve will be same as that of the normal river d/s 

[Figure 3.9(b)] but with an afflux. 
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Figure 3.9 Stage-Discharge Curve (a) Upstream of Barrage; (b) Downstream of Barrage; (c) Downstream 

of Barrage with retrogression 

Subsequestly, at any discharge Q more than Q0, the level of water behind the barrage (Hu) is 

higher than that at the downstream end of the barrage (HD). In a few streams the construction 

of a barrage causes the riverbed on the downstream side to get degraded up to a specific extent, 

a phenomenon which is known as retrogression, which has been observed to be more 

proclaimed in alluvial streams carrying more silt or the streams having finer bed material and 

having steeper slopes. [2] recommends a retrogression value of 1.25 to 2.25 m for alluvial 

streams at lower river stages relying on the amount of silt in the stream, kind of bed material, 

and the slope. As a result of this phenomenon called retrogression, low stages of the river are 

by and large influenced more as compared to the maximum flood levels. The decrease in stages 

due to retrogression, at design flood, may be within 0.3m to 0.5m depending upon whether the 

stream is shallow or is confined amid floods. Figure 3.9(c) demonstrates a typical retrogressed 

water stage-discharge and for the same discharge Q1, the corresponding water level (HD′) will 

be much lower than the upstream water level (Hu). 

The above discussion implies that for the same flood discharge, a non-retrogressed river may 

exhibit submerged flow phenomenon [Figure 3.10(a)] compared to a free flow condition 

[Figure 3.10(b)] expected for a retrogressed condition. As a consequence, there would be a 

difference in scour depths in either case. Nevertheless, IS 6966 [part 1]: 1989 recommends that 

for non-cohesive soils, the depth of scour might be calculated as per the Lacey’s formula given 

by: 

     When looseness factor is more than 1 𝑹 = 𝟎. 𝟒𝟕𝟑 [
𝑸

𝒇
]

𝟏/𝟑
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  or   When looseness factor is less than 1 

where, R = scour depth below the HFL (in meters). 

Q = discharge in the river during high flood(in m3/s) 

q = intensity of flood discharge is in m3/s per meter width 

f =  silt factor which may be ascertained knowing the average particle size mr(in 

mm), of the soil from the relationship: 

f=1.76√d50 

The degree of scour in a stream with erodible bed material fluctuates at different places along 

a barrage. The extent of scour at different points are given in the following table: 

Table 3.2 Extent of scour at various points 

 

 

*A discharge concentration factor equal to 20 percent is to be considered while fixing the 

depth of the sheet piles. These should be suitably stretched out into the banks on both the 

sides up to a minimum of twice their depth from the top of the floors. 

It is quite common to find layers of clay below the riverbed of alluvial rivers in which case, a 

reasonable adjustment in the depths of upstream and downstream sheet-piles shall have to be 

made to avoid building up of pressure under floor. 

𝑹 = 𝟏. 𝟑𝟓 [
𝒒𝟐

𝒇
]

𝟏/𝟑
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3.5 FIXING DIMENSIONS OF BARRAGE PARTS 

The hydraulic calculation for a barrage starts with the determination of the waterway. For 

shallow and meandering streams, the minimum stable width (P) can be figured out from 

Lacey’s modified formula given as, 

P=4.83 Q1/2 

Where Q, the discharge, is in cumecs. For rivers with broad sections, the width of the barrage 

is restricted to Lacey’s width multiplied by the looseness factor and the remaining width is 

obstructed by tie bunds with reasonable training measures. Considering the width of each bay 

to be varying between 18m and 20m and the pier width to be nearly equal to 1.5m, the total 

number of bays is calculated. The total number of bays are distributed between spillway, under-

sluice and the river-sluice bays. 

With these experimental values, the adequacy of the waterway for passing the design flood 

within the permissible afflux needs to be checked up. Otherwise, the waterway and crest levels 

will need to be readjusted in such a way that the allowable values of afflux are not surpassed. 

The discharge through the barrage bays (spillway or undersluices) for an uncontrolled 

condition (similar to flood discharge) is given as: 

Q=CLH
3/2 

Where L denotes the clear waterway (in meters) H, the total head (including the velocity head) 

over crest (in meters) and C represents the coefficient of discharge, which for free flow 

conditions [as shown in Figure 3.10 (b)] may be taken as 1.7 (for broad-crested weirs) or 1.84 

(for sharp-crested weirs/ spillways). If the head over the weir crest is more than 1.5 times the 

width of the weir, the weir behaves as a sharp crested weir. However, with the general 

dimensions of a barrage (with the crest width being kept at about 2m) and the corresponding 

flow depths normally prevailing, it would act like a sharp-crested spillway. Undersluices and 

river-sluices (without a crest) would behave as a broad-crested weir. Another point that may 

be remembered is that the total head H also incorporates the velocity head Va
2/2g, where Va 

represents the velocity of approach and may be calculated by dividing the total discharge Q by 

the cross sectional area, A. The quantity A, might be calculated by multiplying the width of 

river by the depth of flow, which has to be taken as the depth of scour measured from the water 

surface, not as the difference of the affluxed water level and the standard river bed. 
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Figure 3.10 Jump formation modes in the barrage due to same discharge; (a) Submerged jump for high 

tail water level; (b) Free jump for low tailwater level due to retrogression 

It may be noticed from Figure 3.10 (a) that a barrage spillway or an undersluice can also get 

submerged by the tail water. In that case, one needs to alter the discharge by multiplying with 

a coefficient, k, which is subject to the degree of submergence, as shown in Fig 3.11. 

 

Figure 3.11 Multiplying coefficient (k) for the transition from free flow to submerged flow conditions. 

Since the crest levels of the spillway, undersluice and river-sluice bays would be distinct, the 

discharge going through each of them will have to be estimated separately and then added up. 
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Wherever silt excluder tunnels are proposed to be provided in the under sluice bays, the 

discharge passing through these tunnels and over them needs to be calculated separately and 

finally added up. 

As we have already fixed the quantity of spillway, river-sluice and undersluice bays and their 

crest levels, it is now important to work out the length and height of the corresponding d/s 

floors. The d/s sloping apron extending from the fixed crest level to the horizontal floor is 

typically laid at an inclination equal to 3H:1V, and the structure is designed in a manner that 

any hydraulic jump formation during the free flow condition will take place on the sloping 

apron itself. Thus, the worst scenario of low tailwater level, which governs the development of 

a hydraulic jump at the lower-most elevation decides the point of the bottom end elevation of 

the slope as well as of the horizontal floor (Figure 3.12). The length of the horizontal floor (also 

known as the cistern) is governed by the length of jump, which is normally taken as 5(D2-D1) 

where D1 is the depth of water u/s of the jump and D2 is the depth of water d/s of the jump 

(Figure 3.12).  

 

 

Figure 3.12 Jump formation at lowest end of Glacis for (a) Spillway bays; (b) Undersluice bays 

It may be observed from the illustration that though the u/s and d/s water levels of the under-

sluice bays and the spillway are equivalent for a specific flow condition, while the difference 

in the crest elevations causes more flow per unit width to go through the under sluice bays. 

This is the reason for a depressed floor for the undersluices bays compared to the spillway. 
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The level of cistern and its length for the spillway, river-sluice or undersluice bays must be 

calculated for different arrangements of flow and d/s water level permutations that may be 

possible physically on the basis of the gate opening corresponding to the river inflow value, 

The most extreme combination would give the lowest cistern level and the greatest length 

required, the hydraulic conditions that need to be checked will be as follows: 

1) Flow at Pond level, with a few gates opened. 

2) Case 1 with discharge enhanced by 20% and a retrogressed downstream riverbed level. 

3) Flow at High Flood Level, with all gates opened. 

4) Case 3 with discharge enhanced by 20% and a retrogressed d/s riverbed level. 

Calculations of cistern level are done either through the use of the Blench Curves and Montague 

curves, or they may be solved analytically. 

3.6 U/S AND D/S PROTECTION WORKS 

Nearly u/s and d/s of the floor of the spillway apron, the stream-bed is ensured for protection 

by certain strategies like loose stone apron, block protection, etc. as represented in Figure 3.13 

showing a typical section of the spillway of a barrage. These protection works are discussed 

below: 

 

Figure 3.13 Section through a typical barrage spillway 

3.6.1 UPSTREAM BLOCK PROTECTION 

Just beyond the impervious upstream floor, pervious protection consisting of cement concrete 

blocks of satisfactory size laid over loose stone will have to be provided. The blocks of size 

around 1.5m x 1.5m x 0.9m made of cement concrete are used for barrages in alluvial streams. 

The length of the u/s block protection might be kept equivalent to a length D, the design depth 

of scour beneath the floor level as shown in Figure 3.14. 
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Figure 3.14 Upstream Block Protection 

3.6.2 DOWNSTREAM BLOCK PROTECTION 

The pervious block protection will be provided just beyond the d/s impervious floor. It contains 

blocks of size 1.5m x 1.5m x 0.9m made up of cement concrete laid with gaps of 75mm width 

and are packed with gravel. The d/s block protection is arranged on a graded inverted filter 

intended to prevent the uplift of the fine sand particles upwards as a result of seepage forces. 

The filter should roughly follow this design criteria: 

1) 
𝑑15 𝑜𝑓 𝑓𝑖𝑙𝑡𝑒𝑟

𝑑15 𝑜𝑓 𝑓𝑜𝑢𝑛𝑑𝑎𝑡𝑖𝑜𝑛
≥ 4 ≥

𝑑15 𝑜𝑓 𝑓𝑖𝑙𝑡𝑒𝑟

𝑑85 𝑜𝑓 𝑓𝑜𝑢𝑛𝑑𝑎𝑡𝑖𝑜𝑛
  

Where d15 and d85 represent grain sizes. dx is the size such that x% of the soil grains 

are smaller than that particle size. Where x may be 15 or 85 percent. 

2) The filter may be provided in two or more layers. The grain size curves of the filter 

layers and the base material have to be approximately parallel. 

The length of the d/s block protection must be 1.5 times D, where D is the depth of cover below 

the level of the floor. The block protection with an inverted filter may be provided as shown in 

Figure 3.15. 
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Figure 3.15 Downstream Block Protection 

3.6.3 LOOSE STONE PROTECTION 

Beyond the block protection on the u/s and d/s of a barrage located on alluvial foundation, a 

layer of loose boulders or stones have to be laid, as shown in Figure 3.16(a). The boulder size 

should be more than or equal to 0.3m and should not weigh lesser than 40kg. This layer is 

expected to fall below, or launch, when the downstream riverbed starts getting scoured at the 

initiation of a heavy flood [Figure 3.16(b)]. The length of the river bed that must be protected 

with loose-stone blocks shall be approximately 1.5D, where D is the depth of scour below the 

average riverbed. 

 

Figure 3.16 Section through downstream protection 

It might be mentioned that the loose-stone protection must be laid not only downstream of the 

barrage floor, as well as up and down the base of guide bunds, flank dividers, abutment walls, 
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divide walls, undersluice tunnels, as might be seen from the typical layout of a barrage given 

in Figure 3.17. 

 

Figure 3.17 Typical Layout of a Barrage and its Appurtenant Structures 

 

After fixing the dimensions, they barrage components are designed structurally, considering 

the forces evaluated from the hydraulic analysis, The Bureau of Indian Standards Code [23] 

specifies the recommendations in this regard. 

3.6.4 CUT-OFF (SHEET PILE) 

The upstream and downstream cut-offs of a structure might be steel sheet-piles anchored to the 

barrage floor utilizing RCC caps, or might be worked of masonry or RCC. The sheet pile cut-

offs should be made as retaining walls sheet pile anchored at the top end. They will be designed 

to oppose the worst combination of movements and forces considering possible scour on the 

external side, earth pressure and surcharge due to floor loads on the internal side, differential 

hydrostatic pressure computed by the pressure of seepage below the floor etc. In case the impact 

of cut-offs is taken into account for resistance against the forward sliding of the structure, the 

cut-offs should also be intended to withstand the passive pressures developed there. The RCC 

pile caps should be designed to transmit the forces and bending moments acting on the steel 

sheet piles to the barrage floor. 

3.6.5 IMPERVIOUS FLOOR (SOLID APRON) 

There are two kinds of floors, the first being called the Gravity type and the second as the Raft 

type. In the former kind, the uplift pressure is balanced by the self-weight of the floor only 

considering unit length of the floor, whereas the latter considers the uplift pressure to be 
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adjusted by the floor as well as the piers and other superimposed dead loads considering a unit 

span. Contemporary outlines of barrages have also been of the raft-type, and therefore, this 

type of construction is suggested. 

The thickness of the impervious floor might be adequate to counterbalance the uplift pressure 

at the considered point. The thickness of the downstream floor (cistern) must be checked under 

hydraulic jump conditions also, as in this case, the resultant vertical force on the floor is to be 

calculated from the difference of the vertical uplift resulting from the sub-surface flow and the 

weight of water column at any point from above because of the flowing water. 

The design of the raft must be done using the beams on elastic foundations theory and the 

forces as shown below, or their worst combination has to be taken: 

• Differential hydrostatic pressure  

• Forces due to water current 

• Buoyancy 

• Wind forces 

• Hydrodynamic forces due to seismic conditions 

• Seismic forces, if any 

The pier must be designed per the IS-456 as an RCC column. 

For the design of remainig components of a barrage project, like Divide walls, Abutments, 

Flank walls, Return walls, etc., IS: 11130-1984 should be followed. 

This section is taken from [24]. 
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CHAPTER 4: APP DEVELOPMENT 

4.1 NAME  

For the software to be more accessible and approachable the name should be catchy hence it 

was named Application for Barrage Calculations and Design abbreviated as ABCD with an 

aim to perform the A B C D of design of barrages. This was the first version hence, collectively 

its name: ABCD v1.0. 

4.2 LOGO 

The logo also represents the purpose of this application, i.e. barrage calculations and design. 

The logo is as shown in the following figure: 

 

Figure 4.1 Logo 

 

Being coherent with the name, the logo also represents the abbreviation in the following 

manner: 
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4.2.1 A (Application for) 

 

Figure 4.2 'A' of ABCD 

4.2.2 B (Barrage) 

 

Figure 4.3 'B' of ABCD 
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4.2.3 C (Calculations and) 

 

Figure 4.4 'C' of ABCD 

4.2.4 D (Design) 

 

Figure 4.5 'D' of ABCD 
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4.3 PROGRAMMING LANGUAGE 

The application is developed using Python 2.7 programming language. The reasons why it was 

chosen over other languages were: 

 Takes much less time to develop. 

 Built-in high-level data types and its dynamic typing. 

 Powerful polymorphic list and dictionary types. 

 Readable and maintainable code using an elegant but not overly cryptic notation. 

 Python code is typically 3-5 times shorter than equivalent Java code. 

 Python code is often 5-10 times shorter than equivalent C++ code. 

 Indentation. 

4.4 FRAMEWORK 

The framework we used was wxPython. Initially it was being developed on Tkinter, but due to 

the following reasons, had to switch to wxPython: 

 wxPython has large library of widgets 

 wxPython has native look-and-feel. 

 wxPython is very flexible. 

 wxPython has very helpful user community. 

 Tkinter is easy to work upon, but becomes cumbersome with complex interfaces. 

 Tkinter, to be truly usable, requires downloading extra toolkits. 

 Tkinter doesn’t have multi-threading support. 

4.5 REPORTING FRAMEWORK 

4.5.1 HTML FOR TABLES 

The tables were developed on HTML (HyperText Markup Language) because of the ease and 

flexibility in working with the attributes and formatting the table layout. 

4.5.2 INKSCAPE FOR DXF 

Due to the following reasons, we have user Inkscape for developing the DXFs instead of 

AutoCAD: 
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 Inkscape is a free, open source drawing program. 

 Inkscape setup file size is smaller. 

 The hard disk space needed after installation of Inkscape is smaller. 

 It has many of the features of software like Adobe Illustrator. 
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CHAPTER 5: TESTING AND 

VALIDATION 

5.1 SAMPLE PROBLEM  

This problem is taken from [22]. The snapshots from both the book and the developed software 

are being given in this section for comparison. 

5.1.1 Input: 

 

Figure 5.1: Input 
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5.1.2 Solution: 

5.1.2.1 Comparison of Tables 

Table 5.1 Undersluice Portion of Barrage (Book) 
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Table 5.2: Undersluice Portion of the Barrage (ABCD v1.0) 

 

Table 5.3: Levels of Hydraulic Gradient Line for Undersluice Portion (Book) 
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Table 5.4: Levels of Hydraulic Gradient Line for Undersluice Portion (ABCD v1.0) 

 

Table 5.5: Pre-Jump Profile Calculations for Undersluice Portion (Book) 

 

Table 5.6: Pre-Jump Profile Calculations for Undersluice Portion (ABCD v1.0) 
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Table 5.7: Post-Jump Profile Calculations for Undersluice Portion (Book) 

 

 

 

Table 5.8: Post-Jump Profile Calculations for Undersluice Portion (ABCD v1.0) 
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Table 5.9: Other Barrage Bays Portion of the barrage (Book) 

 

 

Table 5.10: Other Barrage Bays Portion of the barrage (ABCD v1.0) 
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Table 5.11: Levels of Hydraulic Gradient Line for Other Barrage Bays Portion (Book) 

 

 

Table 5.12: Levels of Hydraulic Gradient Line for Other Barrage Bays Portion (ABCD v1.0) 
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Table 5.13: Pre-Jump Profile Calculations for Other Barrage Bays Portion (Book) 

 

 

Table 5.14: Pre-Jump Profile Calculations for Other Barrage Bays Portion (ABCD v1.0)

 

. 
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Table 5.15: Post-Jump Profile Calculations for Other Barrage Bays Portion (Book) 

 

 

Table 5.16: Post-Jump Profile Calculations for Other Barrage Bays Portion (ABCD v1.0) 
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Table 5.17: Canal Head Regulator for the Barrage (Book) 

 

 

Table 5.18: Canal Head Regulator for the Barrage (ABCD v1.0) 
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Table 5.19: Levels of Hydraulic Gradient Line for Canal Head Regulator (Book) 

 

 

Table 5.20: Levels of Hydraulic Gradient Line for Canal Head Regulator (ABCD v1.0) 
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5.1.2.2 Comparison of Drawings 

 

 

Figure 5.2: High Flood condition with no retrogression for Undersluice Portion (Book) 

 

 

Figure 5.3: High Flood condition with no retrogression for Undersluice Portion (ABCD v1.0) 
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Figure 5.4: High Flood with concentration and retrogression for Undersluice Portion (Book) 

 

 

 

Figure 5.5: High Flood with concentration and retrogression for Undersluice Portion (ABCD v1.0) 
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Figure 5.6: Pond Level with no concentration and retrogression for Undersluice Portion (Book) 

 

 

 

Figure 5.7: Pond Level with no concentration and retrogression for Undersluice Portion (ABCD v1.0) 
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Figure 5.8: Pond Level with concentration and retrogression for Undersluice (Book) 

 

 

Figure 5.9: Pond Level with concentration and retrogression for Undersluice (ABCD v1.0) 

 

 

Figure 5.10: Line Diagram of Undersluice Floor (Book) 
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Figure 5.11: Line Diagram of Undersluice Floor (ABCD v1.0) 

 

 

 

Figure 5.12: Undersluice Floor Section (Book) 
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Figure 5.13: Undersluice Floor Section (ABCD v1.0) 

 

 

Figure 5.14: Unbalanced Head in jump trough at High Flood Flow (Book) 

 

 

Figure 5.15: Unbalanced Head in jump trough at High Flood Flow (ABCD v1.0) 



 
43 

 

 

Figure 5.16: Unbalanced Head in jump trough at Pond Level Flow (Book) 

 

 

Figure 5.17: Unbalanced Head in jump trough at Pond Level Flow (ABCD v1.0) 

 

 

Figure 5.18: Unbalanced Head in jump trough at Maximum Static Head at Pond Level (Book) 
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Figure 5.19: Unbalanced Head in jump trough at Maximum Static Head at Pond Level (ABCD v1.0) 

 

 

Figure 5.20: Section of Undersluice portion of Barrage (Book) 

 

 

Figure 5.21: Section of Undersluice portion of Barrage (ABCD v1.0) 
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Figure 5.22: Other Barrage Bays Floor Section (Book) 

 

 

 

Figure 5.23: Other Barrage Bays Floor Section (ABCD v1.0) 
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Figure 5.24: Unbalanced Head in jump trough at High Flood Flow (Book) 

 

 

Figure 5.25: Unbalanced Head in jump trough at High Flood Flow (ABCD v1.0) 
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Figure 5.26: Unbalanced Head in jump trough at Pond Level Flow (Book) 

 

 

 

Figure 5.27: Unbalanced Head in jump trough at Pond Level Flow (ABCD v1.0) 
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Figure 5.28: Unbalanced Head in jump trough at Maximum Static Head at Pond Level (Book) 

 

 

Figure 5.29: Unbalanced Head in jump trough at Maximum Static Head at Pond Level (ABCD v1.0) 

 

 

Figure 5.30: Section of Other Barrage Bays portion (Book) 
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Figure 5.31: Section of Other Barrage Bays portion (ABCD v1.0) 

 

 

Figure 5.32: Canal Head Regulator – Initial (Book) 

 

 

Figure 5.33: Canal Head Regulator – Initial (ABCD v1.0) 
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Figure 5.34: Canal Head Regulator during full supply discharge (Book) 

 

 

 

Figure 5.35: Canal Head Regulator during full supply discharge (ABCD v1.0) 



 
51 

 

 

 

 

Figure 5.36: Canal Head Regulator Floor Section (Book) 

 

 

 

 

Figure 5.37: Canal Head Regulator Floor Section (ABCD v1.0) 
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Figure 5.38: Canal Head Regulator in Max. Static Head condition (Book) 

 

 

 

Figure 5.39: Canal Head Regulator in Max. Static Head condition (ABCD v1.0) 
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Figure 5.40: Section of Canal Head Regulator (Book) 

 

 

 

Figure 5.41: Section of Canal Head Regulator (ABCD v1.0) 
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CHAPTER 6: SUMMARY, CONCLUSION 

AND RECOMMENDATIONS 
 

6.1 SUMMARY 

An App was developed for the Design of Small Barrages for the East Indian region using 

Python programming language, HTML and Inkscape. The App calculates the hydraulic 

parameters of a barrage that are set in consideration of surface flow, subsurface flow and nature 

of the foundation soil by Hydraulic Jump theory and Khosla’s theory. It solves the uplifting 

pressure head distribution on the structure using regression from Khosla’s pressure curves, 

allowing for the approximately perfect design of structures built on anisotropic and shallow as 

well as isotropic and deep permeable media with and without consideration of concentration 

and retrogression. The app also provides the hydraulic design parameters for the Canal Head 

Regulator provided at the head of the off-taking canal. Testing and validation of the app is also 

demonstrated using problems from books written by famous authors. This App serves as a 

convenient decision tool for the hydraulic design of small barrages. 

6.2 CONCLUSION 

The App has been tested in Chapter 5 and the results were found to be for the sample problem. 

It is successful in calculating the various forces and design parameters, and hence it can serve 

as a helpful aid in saving an enormous amount of design work-forces’ time and construction 

cost. 

6.3 RECOMMENDATIONS 

The different parameters of the components of a diversion structure are interrelated. Their 

optimum combination is dependent on the cost of construction of the elements at a particular 

site. The practical situation in the construction of water work structures is that the cost of 

material and construction vary; making an optimum design at one point in time (while in design 

stage) to be obsolete at other (during construction). However, with the development of such 

computer programs like this one, the optimum design can easily be prepared at any time 

(including at the construction stage), saving the client an enormous amount of expenses. 
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This particular study focused on developing an application that would solve the surface and 

subsurface flow problems for diversion structure with a sloping apron and founded on porous 

media. Little or no effort is made to include the structural design of gates, piers and some other 

component structures that need special structural design considerations in the computer 

program. Moreover, there is a need to develop the procedure of optimization for least cost 

design, i.e. consideration of permissible afflux, water- way width, wing walls and the top levels 

of aprons.  

The author recommends that there should be a future line of study on least cost design of low-

head diversion structures with considerations for above-stated factors and structural 

development as well.  
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APPENDIX 

The tutorial for the Application for Barrage Calculations and Design (ABCD) v1.0 is given in 

this section from the next page. 
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1 Introduction 

 
This is a tutorial for Application for Barrage Calculations and Design (ABCD) v1.0, 
developed at National Institute of Technology, Rourkela, Odisha, India. 
The software is designed to save time and resources of Water Resources engineers and 
government officials required during construction of small barrages. 
ABCD serves as a powerful tool in calculating different parameters for the hydraulic 
design of Barrages and gives output in the form of tables and drawings (DXFs) 

 

2 Prerequisites  

 
Before proceeding with this tutorial, you should have a basic understanding of Barrage, 
its hydraulic design, and required parameters, Computer peripherals like mouse, 
keyboard, monitor, screen, etc. and their core operations. 

 

3 Installation 

 
This software can be installed by double-clicking the setup file named  
ABCD v1.0 Setup.exe, and then proceeding with the installation. The installation will 
automatically install Inkscape, the DXF output software, as well. 

 

4 Starting ABCD 

 
 Click Start 

 Go to All Programs 

 Search for ABCD and then click on the application. 
This will launch the ABCD application, and you will see the following splash screen: 
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After the application loads, the following welcome screen will be shown to you, which 
will possess a menu bar having two menus File and Help initially, as shown in the 
following figure. 

 
 

Another two menus titled Window and Design will appear as soon as the user either 
opens a saved file or creates a new one. The Menu Bar is explained thoroughly in the 
next section. 

 

5 Menu Bar 

 
The Menu Bar contains the following four menus: 

 File Menu 

 Window Menu 

 Help Menu 

 Design Menu 
 

5.1 File Menu 

 
As mentioned in the previous section, after starting ABCD, the first menu you will 
encounter is the File Menu which will have the following three sub-menus: 

 Create New File (Ctrl+N) 

 Open File (Ctrl+O) 

 Save As (Ctrl+Shift+S) 
They have been explained in detail in the following section. 
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5.1.1 New File (Ctrl+N) 

 
As soon as you click on the New File sub-menu, a dialogue box will open as shown in 
the figure: 

 

 
Enter the filename and Save it so that it can be opened for entering the Input parameters 
as shown in the following figure: 
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After entering these design parameters, click OK to confirm. We have to enter the 
ordinates of the stage- discharge curve of the river at the site of barrage construction 
using this dialog box.  

 

 
To insert another row for inputting the ordinates of the stage-discharge curve, click on 
Add New Row, or click on Remove New Row if you want to delete a new row 
generated. Click OK to confirm.  
The following will appear: 

 

 
The left part contains the input parameters (parameters on the top and stage-discharge 
curve ordinates on the bottom) while the right part contains the plot of the stage-
discharge curve. 
The created file will open inside the software and can be maximized, minimized or 
closed by the respective buttons in the inner window. 
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5.1.2 Open File (Ctrl+O) 

 
After creating a new file and entering the data, it can be retrieved through Open File 
or Ctrl+O shortcut. The following dialog box will appear after you press Ctrl+O or 
Open File: 

 

 
After opening the following window including the input parameters on the left 
(parameters on the top and stage-discharge curve ordinates on the bottom), while the 
plot of the stage-discharge curve on the right appears. It should be noted that multiple 
files can also be opened in ABCD. The current file name is shown at the top in brackets. 
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5.1.3 Save As (Ctrl+Shift+S) 

 
To compare two designs differing in the lesser number of parameters, Save As can be 
used. The shortcut is Ctrl+Shift+S, and the following dialog box will open: 

 

 
It should be noted that ABCD saves files automatically in the background with every 
click. Hence, the software does not have a Save submenu. 

  

5.2 Window Menu 

5.2.1 Cascade 

 
Clicking Cascade option under the Window Menu will cascade multiple windows as 
shown in the following figure. 
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5.2.2 Tile Horizontally 

 
Clicking Tile Horizontally option under the Window Menu will tile the multiple 
windows horizontally as shown in the following figure. 

 
 

5.2.3 Tile Vertically 

 
Clicking Tile Vertically option under the Window Menu will tile the multiple windows 
vertically as shown in the following figure. 
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5.2.4 Next 

 
Clicking Next option under the Window Menu will switch the user from the current 
file to the next file of the opened multiple files. 

 

5.2.5 Previous 

 
Clicking Previous option under the Window Menu will switch the user from the 
current file to the previous file of the opened multiple files. 

 

5.2.6 Opened files 

 
The next part of the Window Menu (after the separator) will show a list of opened 
files, and this can be used to switch the files as shown below: 

 
 

5.3 Help Menu 

 
The Help Menu is divided into the following two parts: 

 About 

 Tutorial 
They have been explained in details in the next section. 

 
 

5.3.1 About 

 
This part will tell the user about the Application for Barrage Calculations and 
Design as shown in the following figure: 
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5.3.2 Tutorial 

 
The next part of the Window Menu (after the separator) will show a list of opened 
files, and this can be used to switch the files as shown below: 

 

5.4 Design Menu 

 
The last menu is Design Menu where the user has to mark the file of which the design 
is to be presented. After that, it will have the following three sub-menus: 

 Tables 
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 Diagrams 

 Additional Details 

 
 

5.4.1 Tables 

 
The Tables submenu of the Design menu of chosen file and the tables it can output 
are shown in the following figure: 
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5.4.2 Diagrams 

 
The Diagrams sub menu of the Design menu for the chosen file and the drawings it 
can output as .DXF using Inkscape are shown in the following figure: 

 
 

5.4.3 Additional Details 

 
The Additional Details sub menu of the Design menu for the chosen file shows the 
additional details for the current design problem. 
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6 Working on ABCD 

 
In this section, we will walk the reader through the operating procedure of this software, 
ABCD. 

 

6.1 Creating/Importing .data 

 
Creating or importing .data files has already been explained in section 5.1.1 and 5.1.2. 
The user is requested to switch to them. 

 

6.2 Calculations and Design 

 
After the data is created/imported, the calculations are done in the background, and the 
results are available to the user in the format of Tables, Diagrams and Additional 
Details. 

 

6.2.1 Tables 

 
As mentioned already in section 5.4.1, the Tables can be accessed from the Design 
menu and will contain the following: 

 Undersluice Portion of the Barrage 

 Levels of Hydraulic Gradient Line for Undersluice Portion 

 Pre-Jump Profile Calculations for Undersluice Portion 

 Post-Jump Profile Calculations for Undersluice Portion 

 Other Barrage Bays Portion of the barrage 

 Levels of Hydraulic Gradient Line for Other Barrage Bays Portion 

 Pre-Jump Profile Calculations for Other Barrage Bays Portion 

 Post-Jump Profile Calculations for Other Barrage Bays Portion 

 Canal Head Regulator for the Barrage 

 Levels of Hydraulic Gradient Line for Canal Head Regulator 

 
 
We will illustrate the case of Undersluice Portion of the Barrage. Click on the 
Undersluice Portion of the Barrage under Tables submenu of the Design menu, as 
shown in the following figure: 
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After clicking on it, a window will appear, consisting of the calculations for the chosen 
case (Undersluice Portion of the Barrage) with three options at the bottom left as 
shown in the following figure: 
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The three options will be: 

 Print 

 Print Preview 

 Page Setup 
 

6.2.1.1 Print 

 
This section is self-explanatory containing normal operations related to Print as shown 
in the following figure: 

 
 

6.2.1.2 Print Preview 

 
This section is self-explanatory containing normal operations related to Print Preview 
as shown in the following figure: 
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6.2.1.3 Page Setup 

 
This section is self-explanatory containing normal operations related to Page Setup as 
shown in the following figure: 

 
 

6.2.2 Diagrams 

 
As mentioned already in section 5.4.2, the Drawings can be accessed from the Design 
menu and will contain the following: 

 High Flood condition with no retrogression for Undersluice Portion 

 High Flood condition with concentration and retrogression for Undersluice 
Portion 

 Pond Level with no concentration and retrogression for Undersluice Portion 

 Pond Level with concentration and retrogression for Undersluice Portion 

 Line Diagram of Undersluice Floor 

 Undersluice Floor Section 

 Unbalanced Head in jump trough at High Flood Flow 

 Unbalanced Head in jump trough at Pond Level Flow 

 Unbalanced Head in jump trough at Maximum Static Head at Pond Level 

 Section of Undersluice portion of Barrage 

 Other Barrage Bays Floor Section 

 Unbalanced Head in jump trough at High Flood Flow 

 Unbalanced Head in jump trough at Pond Level Flow 

 Unbalanced Head in jump trough at Maximum Static Head at Pond Level 

 Section of Other Barrage Bays portion 

 Canal Head Regulator - Initial 

 Canal Head Regulator during full supply discharge 

 Canal Head Regulator Floor Section 

 Canal Head Regulator in Max. Static Head condition 

 Section of Canal Head Regulator 
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We will illustrate the case of Undersluice Floor Section. Click on the Undersluice 
Floor Section under Drawing sub menu of the Design menu, as shown in the 
following figure: 

 

 
After clicking on it, a window will appear, asking the user to enter the filename in which 
the DXF will be saved. This is illustrated as below: 

 
 

 
Then, the user will be shown the Inkscape DXF Input dialog, where the user will enter 
the options as illustrated and Click OK: 
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Finally, the file will open in Inkscape (which is installed with ABCD on the user’s 
system) as shown: 

 

 
To learn more about Inkscape and to see its tutorial, the user is advised to visit 
https://inkscape.org/  

 

6.2.3 Additional Details 

 
As mentioned already in section 5.4.3, the Additional Details can be accessed from the 
Design Menu and following will appear after clicking it:  

https://inkscape.org/
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The three options can be used in the similar way as mentioned in the following links for 
the case of Tables: 

 Print 

 Print Preview 

 Page Setup 
 

7 Exiting ABCD 

 
After doing the requisite work on ABCD, the user can exit by directly following the 
usual Windows procedure. 
There is no need to close multiple files, if any, as ABCD saves .data file with every 
editing. 

 

8 Queries? 

 
We can be reached at abcd.nitrourkela@gmail.com. 

© National Institute of Technology, Rourkela. All rights reserved. 
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